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LYNX Control System Overview
Today’s modern digital multi-format installations have resulted in the development
of an array of new terminal equipment products designed to address the many
needs and demands of such systems. Many devices are complex multi-faceted and
multi-functional modules with an array of options and configuration possibilities. A
comprehensive control system has become an essential component of any modern
terminal equipment installation.
LYNX Technik has always addressed this with a modular and expandable control
system. The two primary building blocks of this control system being hardware
components in form of modular rack controllers and a software application.
Now LYNX Technik has taken the control system to the next level and simplified the
hardware and in addition providing more features and flexibility.

Hardware Components
LYNX Technik used to offer three optional modular rack controllers that could be
fitted into the Series|5000 2RU rack frames along with up to 10 processing cards,
as well as primary and redundant power supply. The main reasons for these
different types of controller cards were the cost effectiveness for larger systems
and the simplicity of expansion.
These key attributes have been maintained with the new control system but now
only one type of controller card with an add-on hardware option is required. As
usual LYNX Technik made sure that this new controller card will work in any
generation of the Series|5000 2RU rack frames.
The controller card and add-on option are shown below.
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R CT 5023 Rack Controller

The R CT 5023 is the basic controller card and is all you need to connect a
Series|5000 2RU rack frame to the APPolo Control software. The controller card has
a LAN network interface that uses the LAN connection on the terminal plate of the
rack frame. All LAN related settings are stored on an internal flash memory. Each
controller card in one system needs to have an individual IP-address.

OH_RCT5023_SERVER

The OH_RCT5023_SERVER option is an independent Linux Server with its own IPaddress. For power and LAN connection it is clipped as a piggyback onto the
R CT 5023 controller card.
Adding the OH_RCT5023_SERVER option to a system, enables features like full
SNMP support, Backup-Restore for the complete system and many more.
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Rack Frame Terminal Connector
The diagram below shows the control system terminal panel connections and where
they are located on the rear of the rack frame. All rack frames are supplied prewired for the control system.

The rack frame terminal connector has a total of five RJ45 connectors. Depending
on the type of controller that is inserted into the frame, these connectors are active
or not. However, now with the new R CT 5023 controller card design, the top four
connectors that are highlighted green (Control I/O) and blue (Extend I/O) are only
required for legacy controller cards (for details regarding legacy controllers please
read the Control System Overview Rev 1).
As the R CT 5023 controller is IP based, the only connector of interest here is the
LAN connector highlighted yellow.
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Attachments
The complete infrastructure with the R CT 5023 is IP based. Therefore, the physical
interconnection between rack frames and computer is established by using an IPSwitch. However, in the IP world having a physical connection isn’t enough. The
components need to communicate with each other which require an additional
logical connection. Thus, in addition to the physical connection, the network
components need to be logically attached to each other.

Let’s build a basic system
To show how a system is initially configured and how it can be expanded, we will go
step by step through the configuration process answering questions along the way.
We will start with a very simplistic and minimal system of one Series|5000 rack
frame with an R CT 5023 controller card.
First of all, the physical IP connections between the PC and the frame need to be
established. In other words, both components need to be connected to the IP
network.
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Now the PC and R CT 5023 need to be logically attached to each other. The
simplest way of doing this is by using the LYNX APPolo GUI software which can be
downloaded from the LYNX Technik AG homepage (www.lynx-technik.com) for free.
After installing and starting the APPolo GUI, open the “Connection Manager”
dialogue (you will find it in the “Tools” menu or simply click the

symbol in the

tool bar). In order to establish an attachment (i.e. logical connection) of the
controller card to the PC, you need to make sure that the IP addresses of the PC
and controller card are compatible.
The “Network Component Configurator” tab of the “Connection Manager” dialogue
provides a very powerful tool to overview and setup the IP configuration of all the
LYNX component in your network regardless of their current IP settings.*
After you have made sure that the IP addresses are correct, go to the “Network
Connections Editor” tab. On the right hand side of this dialogue, all the available
LYNX components in the network will be listed. On the left side, you have an
overview of all the current attachments within the LYNX system.

*For detailed descriptions on the “Network Components Configurator” and alternative ways of adjusting the
LAN related settings of the controller card, please refer to the R CT 5023 manual.
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To attach the controller card to the PC, simply select the designated controller in
the right column and drag & drop it on to “My Computer” in the left column.
Finished! Now you have attached the R CT 5023 controller to the APPolo Control
software.

The “Current infrastructure configuration” column will now show the connection
between your PC and the controller card.
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Adding more frames is just as easy. When more than one frame with an R CT 5023
controller is physically connected to the same network, they will be listed in the
“Available network components” column. Once again, drag & drop the controllers
you want to attach to your PC from the right column on to “My Computer” in the
left column.

The logical interconnection of this system looks as follows:
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Let’s build a system with a server
A direct attachment from a frame with an R CT 5023 controller to the PC running
the APPolo GUI software is fine to setup the individual processing modules within
those frames.
Sometimes however, a more elaborate control system is required. For example if
you need a constant logging, want to remote control the LYNX equipment via a
third party soft- or hardware, SNMP or the LYNX IP remote control protocol (API) is
needed. Another scenario would be if you want to store and restore the settings of
all the processing modules within the system. In this case you would require the
LYNX Backup/Restore function. These and many other features are part of the
OH_RCT5023_SERVER option.
As briefly described at the beginning of this document, the OH_RCT5023_SERVER
can be added to an R CT 5023 controller card.

OH_RCT5023_SERVER

However, despite this option being clipped to a controller card, it is a completely
independent network component. The only reason it is clipped to the R CT 5023
controller card is because the server uses the controller as power source and as a
gateway to the network (i.e. it uses the same LAN connection as the controller card
but has a different IP address).
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The physical connection of the frames stays the same, even for the frame hosting
the R CT 5023 controller card with the OH_RCT5023_SERVER option clipped to it.

In the “Network Connections Editor” tab of the “Connection Manager” dialogue, you
will now see the server highlighted with a bold font.
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To setup the connection, first drag & drop the server entry from the right to the left
column.

The logical connection between the APPolo GUI running on your PC is established.
Now drag and drop the R CT 5023 controller card from the right to the left column
but drop it onto the server entry in the “Current infrastructure configuration”
column.

The R CT 5023 is now attached to the OH_RCT5023_SERVER.

© 2016 LYNXTechnik AG

Page 13 of 36

Control System Overview
In the “Network Connections Editor” this setup will be displayed as follows:

You can attach multiple R CT 5023 controller cards to this server. Attaching the
controller cards to the server and not directly to the PC running the APPolo
software, makes the additional server functionalities available for these controllers.
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Redundant Server setup
Due to this very flexible way of attaching R CT 5023 controller cards to a server, it
is really easy to setup a redundant server system. Simply clip an additional
OH_RCT5023_SERVER board to any of the other R CT 5023 controller cards. Now
all you have to do is to additionally attach all of the controller cards in your system
to the new server. As the controller cards hosting the OH_RCT5023_SERVER
options are completely independent from the server, even these can be attached to
two different servers in the system.

© 2016 LYNXTechnik AG

Page 15 of 36

Control System Overview

The LYNX APPolo Control Software
The APPolo Control Software is the heart of a centralized control system. It is a
Windows based application and can be run on any Windows PC (Windows 7 /
Windows 8 / Windows 10).
The basic software package is supplied at no charge, and can be downloaded from
the LYNX website (www.lynx-technik.com). Several software plug-ins are available
(by license) for the OH_RCT5023_SERVER option, which add additional features.
The basic software is a fully featured package with no limits on system size, and for
most applications the optional features are not required.
The software plug-ins provide the following additional functionality:
OC_RSL_FUNC
-

System wide backup and restore of module settings (Backup/Restore)

-

Each parameter in the system can be made available or not for individual
users (User Access)

OC_RSL_CTRL
-

Full “Simple Network Management Protocol” support (SNMP)

-

LYNX IP Remote Control Protocol (API)

OC_CUSTOM_CONTROL
-

Design virtual control panels accessible via PC or iPad

-

Each virtual control panel assignable to one or more users

OC_AUTOCONTROL_BASE
-

Add automation and programmable intelligence inside the APPolo System

-

Use a fixed value of any parameter of any module in the system as a trigger
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-

Set any parameter of any module in the system to a fixed value

OC_REDUNDANT_SERVER
-

Redundant servers will synchronize each other automatically

-

Automatic failover

Passive Operation
The control system software application and hardware are completely passive in
nature. All settings for the modules are stored in the individual modules’ Flash RAM.
Nothing is stored in the PC. The APPolo Control software application and controller
hardware merely provide a mechanism to view and change the settings stored
within the individual modules’ Flash RAM.
Should a PC running the control system be shut down, a network error be
encountered, or an R CT 5023 hardware completely fail, there will be no impact on
the modules’ normal operation and settings.
This passive design philosophy was deliberate as terminal equipment is typically
used in critical applications where continuity of use and reliability is paramount. The
passive nature essentially isolates the control system from normal operations as
critical a point of failure.
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Graphical User Interface
The Graphical User Interface (or GUI) is intuitive and designed to be used on a
Windows PC. It can be driven almost exclusively with a mouse and pointing device.
The layout is shown below:
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Device Tree
The left hand side of the GUI is dedicated to the device browser where all racks and
modules are listed by hierarchy (1). This is the main navigation area in which you
can select any of the processing modules as well as controller cards and servers
attached to your system. The names of each individual module can be customized
to fit your application, simply by right clicking on the module and selecting
“Rename”. The customized names are stored on the server (or PC if the R CT 5023
are connected directly without a server) together with the slot position and board
type. Therefore, even if you replace the module with another module of the same
type, the customizer name will remain.
To the left of each device entry is a colored circle – green, yellow, or red, and is a
direct representation of the general alarm LED located on the front of module.
When the module is selected in the device browser you will see this alarm displayed
in the top right hand corner of the GUI (7), where the specific error message is also
displayed. If configured as an event to record in the event log, the error message
will also be time stamped and recorded.

Favorites
The top part of the browser showing folder symbols (2) is the so called “Favorites”
tree. In this area you can build your own additional device tree that is independent
from hierarchy and can be made to fit exactly your application.
Especially in larger systems this is very useful, as there may be subsets of modules,
which require frequent access.
Building the “Favorites” tree is as simple as can be. Right click into the “Favorites”
area to create a folder. To add a device, simply drag & drop it from the standard
device tree into the “Favorites” tree.
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Log Area
The lower window which spans the bottom of the GUI (3) is the log area where all
events are logged and time stamped. To quickly access one of the modules that
caused a log entry, simply double click on the log entry in question.

Control Area
The main body of the GUI (4) shows the specific controls of the module selected in
the device tree or the “Favorites” tree. To keep the control area as simple as
possible and depending on the complexity of the module, the controls are grouped
on different tabs.

Tool Bar
On the far left of the GUI (5) the tool bar is located which provides short cuts to the
different sections of the APPolo GUI (e.g. the “Connection Management” dialogue as
described previously).

Locating Modules
In larger systems a problem may develop with a specific module which requires
some attention or maintenance. With multiple racks in a machine room, which in
turn may contain many types of the same module, the process of physically
locating the correct device can be daunting, especially if the system is live. The last
thing you would want to do is remove the wrong module. We provide a simple
solution for this within the control system. Each module has a “locate” button at the
top right of the GUI (6), and clicking on this button will flash the module alarm LED
yellow making it simple to physically locate the device. The alarm LED can be seen
with the rack front panel closed.
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Module Graphic Representation

For the more complex modules it is very advantageous to graphically represent the
modules internal signal processing and indicate signal flow.
This provides an intuitive and logical method to access specific areas of the device.
For example, the previous image represents the graphical user interface of the
P VD 5840 Frame Synchronizer which is one of our more complex devices. The user
interface of this device uses the APPolo flexGUI with its 3D navigation. The idea is
based on the concept of showing the functionality of a module as a signal flow
diagram. Parts of this signal flow diagram are the processing block.
The user can navigate around the module by double-clicking on a specific
processing box in the diagram. The software will then zoom into the selected
processing block. From a certain zoom level onwards, the surface of the processing
block will dissolve and reveal the controls. Double clicking anywhere outside of the
processing block will zoom out again to the next highest level showing for example
the overview.
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Additionally it is possible to freely navigate as well as zoom in and out within this
module/system flow diagram. There are three possibilities to do this.
1. Mouse
Using the mouse wheel will seamlessly zoom in and out. Rolling the mouse
wheel forward will zoom in to the position of the mouse curser and rolling it
backwards will zoom out.
To navigate, simply click and hold anywhere outside of a processing block and
move the mouse.
2. FlexGUI Navigator
At the top left of the screen is a dimmed navigation tool.
Hovering over it will bring it to the foreground.
With this navigation tool it is possible to zoom in and out either
by using the slider or the + and – buttons.
The “Fit” button will zoom out to the next highest zoom level.
At the top of this navigation tool is a field with four arrows to
move up, down, left or right.
3. Keyboard
Using + and – on the keyboard will zoom in and out. The home button
provides the “Fit” functionality and the up, down, left and right keys can be
used to move up, down, left and right.
You will also note from the screen shot above that the signal inputs (1) are
highlighted with colors; this indicates the condition of the input. Green is OK, yellow
indicates a possible conflict or problem, and red means not present.
The input (1) as well as the output (2) names can be customized to fit you
installation. Simply right click onto the designated input or output entry and select
“Rename”.
Another innovation of the APPolo flexGUI is the Path Highlighting feature. This helps
to visualize the signal flow of individual signals within the complete diagram.
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Hovering over a path will highlight the complete path from input to output, as well
as the relating paths (e.g. the audio paths being embedded/de-embedded into/from
the SDI path). Therefore it makes a difference at what point of the path is being
hovered over. For example, hovering over the SDI input path will highlight all the
paths (video and audio) coming from this SDI input  it shows where all the signals
are going to (see screenshot below).

Hovering over this same SDI path but to the right of the de-embedder (i.e. after
de-embedding), only the SDI path will be highlighted (see screenshot below).
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Therefore, hovering over the output will only highlight the paths leading to this
output (see screenshot below).
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Signal Switching
The APPolo flexGUI introduces a new way of switching video signals. Instead of
having the traditional matrix cross bars, a simple drag and drop operation has been
integrated (see screenshot below).

Hovering over a switchable path will show a round handle. Clicking and holding the
left mouse button will grab the handle. At the same time the possible options (i.e.
positions the signal can be switched to) are highlighted with an aura.

As soon as the handle is moved close to one of the highlighted options, the handle
will automatically snatch to it.

Letting go of the left mouse button will complete the switch.
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To switch audio signals you have the choice between the same simple drag and
drop operation described above for video or a matrix style control. To turn on the
matrix style control select “Audio CrossBar Matrix” in the View menu.
This additional audio crossbar style is available from Release 8.2.0. onwards.

When the “Audio CrossBar Matrix” is activated and you hover over a crossbar, a
checkered surface is displayed showing the actual crosspoints. The currently
switched crosspoints are highlighted with a blue frame. The crosspoint that the
mouse pointer is hovering over is colored blue to highlight which crosspoint will be
switched if the mouse button is clicked. In addition to this the “CrossBar Inspector”
at the bottom left of the GUI will indicate the source and destination of this
highlighted crosspoint.
To access the mono controls of a crosspoint, right-click on the desired stereo
crosspoint and select “Show Mono Controls” from the context menu. The principal
of switching the mono channels then works exactly the same way as for the stereo
channels.
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Timing Tab
For modules with adjustable audio and video delay you can visualize and change
these delays by double clicking and zooming on the Timing processing blocks
depicted as blue discs with a “t” inside in the main flexGUI View.
As of Release 8.2.0 these modules will have an additional “Timing Tab” where all
the different delays and their relative positions to each other are visualized in a
timeline (see screenshot below).

System Events
The APPolo Control System software includes its own error logging system, which
can be seen at the bottom of the GUI.
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Every module can be configured for the events the user wishes to log. This is to
prevent the log being filled with unnecessary clutter. There will be circumstances
where for example an input video signal will routinely go missing as the input
sources are frequently changed – and for the given application this behavior is
considered normal. In this case you can disable the logging of the event on the
module. Likewise, you may only want to log when a specific event happens, and not
when it’s corrected. For example you want to log when a signal goes missing, but
are not interested in logging when the signal returns.
Every module has an “Events” tab where the error reporting can be configured for
each individual module. See the screen shot below for an example of recordable
events for the PVD 5840 Frame Synchronizer.
It is also possible to configure the SNMP traps sent to an external monitoring or
logging device in the same way. In the screen shot above SNMP is grayed out
because the option OC_RSL_CTRL is not activated (OH_RCT5023_SERVER is
required for SNMP feature).
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Backup Solutions
With some of the more complex modules having upwards of 1000 parameters
which can be set by the user, some form of backup policy is vital. While the module
settings are always stored in non-volatile Flash RAM (which will survive power
failures) it does not protect against hardware failure which requires the device to be
exchanged for a new unit. Exchanging the hardware would require all the settings
be manually reset, assuming the settings were actually documented somewhere.
LYNX provides two backup solutions.

HotSync Backup
Part of the basic free software package is what we refer to as “HotSync Backup”.
This is designed primarily to address the issues mentioned above with regards to
maintenance and protection against hardware failure. While included with the basic
software package it is not actually a function of the control system software at all
(aside from switching it on). The HotSync Backup feature is a function of the
individual R CT 5023 controller cards installed in each rack frame. When enabled for
the specific controller it will immediately take an inventory of the modules installed
in the rack, and take a copy of all the modules settings which are backed up into
the controller’s own internal Flash RAM. When the module’s settings are changed,
the backup copy is immediately (and automatically) appended with the new
settings - this ensures the module backup is always current and up to date. The
system will detect when the module is removed and exchanged for a new unit, and
will automatically restore the backup copy of the settings into the new module. This
process only takes a few seconds. This is an ideal solution as there is no backup to
initiate or schedule, and is 100% automatic always running in the background.

System Wide Backup
There may also be a need to backup a complete system configuration. This is
addressed with the optional software plug-in “Backup/Restore.” This backup
process is a function of the OH_RCT5023_SERVER and the settings are stored as a
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file (or backup set) on the server. Of course it is possible to export and import
these backup files to and from the PC running the APPolo control software.
The Backup/Restore application is useful if the LYNX system is used for different
applications (or sessions) and the system configuration needs to be globally
changed on a regular basis. The screenshots below show the backup and restore
GUI screens.
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Copy & Paste
When working with a larger system it is likely that modules of the same type need
to be setup in the same way. As the number of parameters of some modules can
exceed 1000, setting up multiple modules can be extremely time-consuming.
Specifically for this reason LYNX Technik AG included a copy & paste function into
the APPolo control software.
Setup one of the modules as required, right click onto the device in the device tree
and select “Copy Settings” in the “Settings Management” menu. Afterwards, simply
right click onto the module you want to paste the settings to and select “Paste
Settings” in the “Settings Management” menu.

Update Manager
One section of the APPolo GUI software is dedicated for the update of the modules.
To open this section you can use the tool bar icon

or select “Update Manager”

in the “Tools” menu.
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To access this GUI section, it is required to register your software. To register, open
the help menu and select “Registration/Login”. A wizard will guide you through the
registration process.

The “Update Manager” provides the possibility to mirror our complete database of
programming files onto your local PC and keeping it up-to-date by synchronizing it
via Internet. The intuitive user interface makes it really easy to overview the
current release versions of your modules and also to see if new ones are available.
Due to the local database you can not only read the release notes of the new
firmware version before upgrading but can browse all the releases of all products
and read the release notes of each individual one.
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Test Drive the Control System
A thorough explanation of the APPolo Software as it relates to all functions and
modules is beyond the scope of this document. Using the application for yourself
will make it apparent how intuitive and easy to use the software is.
The LYNX APPolo Control Software Application can be downloaded for free from the
LYNX Technik AG website - download the file onto your desktop and click to install http://www.lynx-technik.com/en/support/download-area/appolo/
When the application has started you can select “Device Simulation” in the “View”
menu. Once selected the device browser will populate itself with a simulated system
(much the same as it would during the discovery process if actual hardware was
connected) of our current product range. This essentially gives you a fully simulated
system with no actual hardware attached. The application is fully functional; you
can browse through all the LYNX modules, change settings and even simulate
system events (or error conditions) in the events tab.
If you have questions or need additional help configuring the control system for a
specific installation or applications please feel free to contact LYNX Technik, and we
will be more than happy to assist.
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ANNEX A
Integration in to a legacy installation
If you already own a LYNX Technik Series|5000 installation, you are probably
wondering how you can expand your current system that is using the legacy
controllers R CT 5031, R CT 5021 and R CT 5010 with the new R CT 5023 controller
card. As a matter of fact, this is really simple but first things first. Below is an
image showing the setup and connections of a legacy installation.
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The frame with the R CT 5031 controller is the only one that is connected to the
network. All the other frames with R CT 5021 and R CT 5010 controller cards have
a serial interconnection to the R CT 5031 frame.
The R CT 5023 doesn’t provide a serial connection, therefore the only way to add a
frame with this controller card to the system is via network. If you open the
“Network Connections Editor” tab of the “Connection Manager” dialogue, you will
notice that the R CT 5031 is represented as a server (i.e. bold font). This is because
the R CT 5031 controller card has the server functionality of the
OH_RCT5023_SERVER included. Due to this fact, adding R CT 5023 controller cards
to you existing system is to simply attach these controllers to the R CT 5031 master
controller as if you were attaching to the OH_RCT5023_SERVER (see chapter “Let’s
build a system with a server” for detailed descriptions).

By the way, the R CT 5021 controller card also has the ability to be connected via
network. In this mode it can be attached like an R CT 5023 controller to any server
(i.e. OH_RCT5023_SERVER or R CT 5031).
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